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About This Manual

This manual is a printable Acrobat PDF version of the FPGA Advantage with 
LeonardoSpectrum Tutorial.

The screen shots and path name convention (/) are the same as those used in the 
Windows environment. The screen shots shown in the Windows environment will 
look different to the ones that will appear when using the tutorial with UNIX 
workstations. However, the design flow is the same for any configuration on all 
platforms.



FPGA Advantage Tutorial Welcome to FPGA Advantage
FPGA Advantage Tutorial

Welcome to FPGA Advantage
This simple tutorial presents a complete design flow using a sample text design 
and Text HDL import, HDL generation, and simulation through to synthesis in 
approximately 30 minutes.

You should have installed at least one configuration of FPGA Advantage and 
obtained your evaluation or permanent licenses before starting this tutorial. 
Temporary evaluation licences can be obtained for FPGA Advantage from the 
FPGA Advantage website.

i
The design used in the FPGA Advantage with LeonardoSpectrum  
Tutorial is based on HDL code recovered using HDL2Graphics 
technology. You can choose to complete the tutorial by using either 
VHDL or Verilog languages.
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Invoking on Windows FPGA Advantage Tutorial
Invoking on Windows
You can invoke your installed configuration of FPGA Advantage on Windows by 
double-clicking the shortcut which was created by the install program on your 
desktop. Alternatively, you can choose the same shortcut from the FPGA 
Advantage 6.1 cascade of the Programs menu. 

For example:

Start > Programs > FPGA Advantage 6.1 > FPGAdv with LS

Invoking on UNIX or Linux
When you install FPGA Advantage on UNIX or Linux systems, invoke scripts are 
created for each configuration in the install program as shown in the table below. 
The scripts and corresponding shortcut links are located in the following 
subdirectory of your installation: <install_dir>/Fpgadv/bin 

Configuration Script

FPGA Advantage with 
LeonardoSpectrum

fa_with_ls

FPGA Advantage with 
Precision Synthesis

fa_with_ps

FPGA Advantage with 
LeonardoSpectrum and 
Precision Synthesis

fa_with_ls
fa_with_ps

FPGA Advantage with 
Precision Physical Synthesis

fa_with_pp

i Refer to the FPGA Advantage Start Here Guide to see a full list of 
configurations supported with FPGA Advantage 6.1.
FPGA Advantage with LeonardoSpectrum Tutorial, Software Version 6.12
  4 June 2003



FPGA Advantage Tutorial Invoking on UNIX or Linux
When FPGA Advantage is first invoked, the HDL Designer Series (HDS) Design 
Manager will be displayed showing the FPGA Advantage Welcome screen:

Click the OK button to remove the Welcome screen.
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Exploring The Designs FPGA Advantage Tutorial
Exploring The Designs
The Design Manager is divided into two browsers. The first browser shows the 
Project Manager with several example designs shown in a list of Regular 
Libraries. The designs include a mixed language HDL text design named 
UART_TXT, a graphical VHDL design named UART and the corresponding 
graphical Verilog design named UART_V.

i
The details of the current user project, My Project is shown inside the 
tooltip in the screenshot above. By default, the examples directory 
appears as the current project when FPGA Advantage is first invoked.

For example: $HDS_HOME\examples\examples.hdp 
FPGA Advantage with LeonardoSpectrum Tutorial, Software Version 6.14
  4 June 2003



FPGA Advantage Tutorial Exploring The Designs
The second browser named Project lists the current active shortcuts you can use 
in the Project Manager. The remaining shortcuts become available when you open 
different windows in the Design Manager.

i Protected Libraries: contain reusable design objects or standard 
packages which are not generated or recompiled.
Downstream Only Libraries: contain compiled data. For example 
from ModelSim and Precision Synthesis.
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Set the Default Language FPGA Advantage Tutorial
Set the Default Language
Choose Main from the Options menu to display the Main Settings dialog box. 
Select Verilog as the default language for all new diagrams. Click the  
button to confirm your language choice and then  to close the dialog box.

i The FPGA Advantage with LeonardoSpectrum Tutorial can be 
completed using either Verilog or VHDL languages. For the purposes of 
this tutorial the Verilog language has been selected.
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FPGA Advantage Tutorial Open Library
Open Library
Double-click the SCRATCH_LIB library shown in the list of Regular Libraries 
in the Project Manager. 

The Design Explorer now shows the empty SCRATCH_LIB library.

i The SCRATCH_LIB library will be used to import an example design 
using HDL Import. 

Notice the path shown inside the tooltip now shows the directory where 
FPGA Advantage is installed.
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Import the Fibonacci Design FPGA Advantage Tutorial
Import the Fibonacci Design 
This tutorial uses a Fibonacci sequencer design which can be imported as either 
VHDL or Verilog code. The design is imported using the HDL Import Wizard 
which recovers the VHDL or Verilog code using HDL Import technology. The 
code is converted into HDS text views and displayed in the SCRATCH_LIB 
library in the Design Explorer.

Click the  button on the Design Manager toolbar to invoke the HDL Import 
Wizard. Alternatively, choose HDL Import from the HDL menu.

Select Specify HDL files in the first page of the HDL Import wizard:  

Click the Next button to display the Specify HDL Source Files page of the HDL 
Import Wizard.

Select Source HDL Files
Use the Browse button to locate the Fibonacci sequencer source code in the 
examples sub-directory of your FPGA Advantage installation as shown in the 
Directory entry box below. For example, if FPGA Advantage has been installed 
in the directory D:\Builds\FPGAdv61, the pathname to locate all source HDL files 
would be:

D:\Builds\FPGAdv61\Hds\examples\tutorial_ref\Import

i
This tutorial can be completed using either the VHDL or Verilog example 
code depending upon your language preference. The language will be 
determined automatically providing that the source code file extension is 
recognized in the general preferences.
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FPGA Advantage Tutorial Select Source HDL Files
Use the Files of type pulldown to select either VHDL or Verilog files. For 
example, Verilog files are shown for the purposes of this tutorial:

Check the Search Sub Directories check box.

Select the Sequencer\Seq_Generator and the Sequencer\Seq_TestBench HDL files 
by using +  mouse button. Click  to convert the files. 

Click the Next button. You will now see the Log Window showing the Verilog 
source files for the Fibonacci design as they are read in:
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Select Source HDL Files FPGA Advantage Tutorial
The HDL Import Wizard Target Libraries dialog box appears showing the 
SCRATCH_LIB library as the default target library. 

Click the Next button.

The HDL Import Wizard Target Directories dialog box appears showing where 
the imported files will appear below the root HDL mapping:

Click the Finish button.
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FPGA Advantage Tutorial Select Source HDL Files
The HDL Log Window will indicate that a hierarchy of designs is being 
automatically created for the Fibonacci design. The Log Window will show the 
following summary report: 
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Browsing the Fibonacci Design FPGA Advantage Tutorial
Browsing the Fibonacci Design
Select the SCRATCH_LIB library in the Design Manager. Click the right mouse 
button and choose Expand All from the popup menu. The design units for the 
Fibonacci design should now be displayed in the Design Explorer as shown 
below:    
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FPGA Advantage Tutorial Examine the State Machine Text View
Examine the State Machine Text View
Double-click on the  icon representing the control component design unit in the 
Design Explorer which will display the state machine shown in the DesignPad 
text editor. 

Use the scroll bar to view the Verilog code and notice that there are two deliberate 
errors which have been added on the following lines:

193 clear = 1 ; // Deliberate error, signal is declared as clr
199 clear = 0 ; // Deliberate error, signal is declared as clr

Close the text editor by choosing either Close Window from the Window menu 
or you can use the keyboard shortcut Ctrl + F4.

i
The deliberate errors will appear on lines 195 and 200 in the VHDL 
version of the state machine code.
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Correct the State Machine Errors FPGA Advantage Tutorial
Correct the State Machine Errors
Select the component design unit icon  for fibgen_tb which is displayed with a 
"top of design" marker  in the HDS Design Manager. 

Press the ModelSim Flow button  on the Design Manager toolbar.

Notice that the HDS Log Window now displays a single error message. This 
represents the two deliberate errors shown in the previous topic.

Make the Log Window active and double-click on the error message. DesignPad 
will now appear allowing you to edit the errors in the state machine source code.

Correct both of the errors by replacing the word clear with clr and delete all of the 
comment text after the semi-colon. Repeat this procedure for the second 
occurrence of the error.

The modified Verilog code should look similar to the example shown below:

Click the  button on the DesignPad toolbar to save the edited source file.

Close DesignPad by choosing either Close Window from the Window menu or 
you can use the keyboard shortcut Ctrl + F4.

Close the Log Window.

i When using the VHDL language a total of seven errors are displayed in 
the Log Window.
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FPGA Advantage Tutorial Create Graphical Test Bench
Create Graphical Test Bench
From the Design Manager click the  button and choose Specified from the 
pulldown menu. The File Creation Wizard appears prompting you to specify a file 
type. Double-click  Block Diagram from the File Types list to open  the 
diagram. Alternatively, select Block Diagram and click Finish on the dialog box.

An Untitled block diagram appears. Click the  button on the block diagram 
toolbar to display the Component Browser showing the Fibonacci design.

From the Component Browser select the fibgen component, hold down the left 
mouse button and drag the component onto the block diagram. Repeat this 
procedure for the fibgen_tester component. The diagram should look similar to 
the one shown below:  

Close the component browser.
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Create Graphical Test Bench FPGA Advantage Tutorial
Select the fibgen component and use the right mouse button to choose Add Signal 
Stubs from the popup menu. The Add Signal Stubs dialog box appears prompting 
you to choose the type of ports that require signal stubs. Click  to accept 
the default setting and notice that two signals, clock and reset are added to the 
diagram plus a bus named fibout.

Repeat this procedure for the fibgen_tester component. The WARNING messages 
which appear can be ignored. This is because the net clock and reset already exist 
and the port and net declarations differ. Click  to acknowledge the 
warning message. 

Note from the diagram that two further clock and reset signals have been added 
plus a second bus named monitor. 

Select and delete the bus fibout. Drag and connect the bus monitor to the port 
fibout. 

The finished diagram should look similar to the one shown below:

i It is not necessary to explicitly connect the clock and reset signals 
between each port on the component and tester as these are implicitly 
connected by name.
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FPGA Advantage Tutorial Save the Test Bench
Save the Test Bench 
Use the  button to save the test bench. The Save As Design Unit View dialog 
box is displayed which allows you to save a design unit into any currently mapped 
library. The columns allow you to specify the design unit name with its default 
view type.

The SCRATCH_LIB library appears by default (as shown).

Save the Design Unit name as fibgen_tb. The Save As Design Unit View dialog 
box should look the same as the example below:

Click the  button to save the test bench. 
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Simulate Your Design FPGA Advantage Tutorial
Simulate Your Design
Select the struct view below fibgen_tb from the Design Manager and choose Set 
Default View from the popup menu. This will define the graphical test bench 
view struct as the default view before simulating the design. A blue triangle now 
appears next to struct indicating that it is now the default view.

Select the fibgen_tb component and select the  button from the toolbar which 
will set up and automatically generate and compile HDL for the hierarchy below 
the selected design unit. The Start ModelSim 5.5-5.7 dialog box will now appear.

Ensure that the Enable Communication with HDS option is set and click the 
 button to confirm the dialog box. 

If generation and compilation are completed successfully, the ModelSim simulator 
is invoked and the entire compiled design is loaded. Messages will now appear in 
the HDS Log Window confirming that the HDL has been compiled for all the 
HDS design units. 

i The progress of HDL generation and compilation are shown in the HDS 
Log Window. Notice that most design units are generated but all design 
units are compiled. If any compilation errors are detected when you 
compile a design, you can cross-reference from the HDS Log Window 
to the source graphics or generated HDL in the same way as for HDL 
generation errors.
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FPGA Advantage Tutorial Add Probes to the Test Bench
Add Probes to the Test Bench
Make the fibgen_tb block diagram active.

You can select multiple signals by using +  mouse button or by dragging a 
box crossing the required signals.

Select the two signals clock and reset and the bus monitor as shown in the 
diagram.

Notice that when the simulator is invoked there is an additional simulation toolbar 
displayed at the bottom of the HDS block diagram. Click the  button to add 
simulation probes showing the current value of each signal.
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Add a Breakpoint FPGA Advantage Tutorial
Add a Breakpoint
In the fibgen_tb block diagram view, choose Structure from the View cascade of 
the Simulation menu in the design browser. A window showing the fibgen_tb 
hierarchy will appear. Expand the hierarchy underneath UUT and select the FSM: 
control view.

The VHDL version of the fibgen_tb hierarchy is shown underneath iO:

In the fibgen_tb block diagram view, choose Source from the View cascade of the 
Simulation menu to open the state machine source window as shown below. 
Navigate to line 193 and use the left mouse button to add a breakpoint to the line. 
Alternatively, choose the right mouse button and select Enable Breakpoint 193 
from the popup menu. A red dot will be shown indicating that a breakpoint is now 
set on line 193. 

i Line 195 is used to set the breakpoint when the VHDL language is used.
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FPGA Advantage Tutorial Run the Simulator
Run the Simulator
Make the fibgen_tb block diagram active and ensure that the bus monitor and the 
signals clock and reset are selected. Click the  button to automatically open the 
ModelSim Wave window. Select the fibgen_tb/monitor bus as shown, and press 
the right mouse button and choose Unsigned for the Radix cascade of the popup 
menu.

In the fibgen_tb block diagram view click the  pulldown next to the   button 
and choose run 100 from the popup menu to advance the simulation by 100 
nanoseconds. Notice that the signal values are initialized in the simulation probes 
on the test bench block diagram. 

Click the  button to run the simulator until the next breakpoint. Notice that the 
waveform appears as the simulation advances. Notice that a blue arrow appears 
over the red dot in the Seq__Generator.v source window.

Finally, make sure that the Seq__Generator.v source window is active and remove 
the breakpoint by choosing Remove Breakpoint 193 from the popup menu.

Alternatively, choose Breakpoints from the Tools menu. A dialog box will 
appear showing all breakpoints currently set. Select the breakpoint which appears 
on line 193 and press the Delete button. Click OK to close the dialog box.
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Complete the Simulation FPGA Advantage Tutorial
Complete the Simulation
In the fibgen block diagram click the  button adjacent to the  button on the 
toolbar and select Choose from the popup menu. Another dialog will appear 
prompting you to enter a time interval to run the simulator. Enter 3000 into the 
entry box and click OK to run the simulator.

Make the ModelSim Wave window active and choose Zoom Full from the Zoom 
cascade of the View menu. This will display the full simulation waveforms which 
should look similar to the picture below for a successfully verified design.

Simulation is now complete. Choose Quit from the ModelSim File menu to exit 
from the simulator. Click Yes to the exit message. Close the fibgen_tb block 
diagram. 

i
Alternatively, you can enter a time interval in the ModelSim window and 
then run the simulator.
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FPGA Advantage Tutorial Invoke LeonardoSpectrum
Invoke LeonardoSpectrum
Select the fibgen component in the HDS Design Manager and then click on the 

 button. The LeonardoSpectrum Invoke Settings dialog is displayed. Select 
the technology of your choice in the Quick Setup tab. 

For example, choose FPGA and Xilinx XC4000E by using the  buttons to 
expand the list of FPGA technologies available. 

i
You cannot synthesize a test bench, so you must select the top level 
design unit of the actual design you want to synthesize.
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Invoke LeonardoSpectrum FPGA Advantage Tutorial
When you select a technology, default values are automatically entered in the 
Device Speed Grade and Wire Table fields (these may vary from the ones 
shown below). The remaining fields will be set by default. Enter the value 20 in 
the Design Frequency field and synthesize your design by clicking the OK 
button. 

You are prompted to confirm the LeonardoSpectrum license. 

A Tip of the Day dialog box may appear. Click OK to clear the dialog box and 
LeonardoSpectrum is invoked on the entire design and the HDL files for your 
design are shown in the Quick Setup tab.

i You must choose a Level 2 license if you are using any of the FPGA 
Advantage Personal configurations. If you are using any of the FPGA 
Advantage configurations, select a Level 3 license. You can uncheck the 
Run license selection next time option if you want to run synthesis 
without prompting for the license level next time you invoke.
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FPGA Advantage Tutorial Invoke LeonardoSpectrum
LeonardoSpectrum will optimize the design. Progress and completion messages 
will be displayed in the information window showing that the synthesis run has 
finished.
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View the RTL Schematic FPGA Advantage Tutorial
View the RTL Schematic
If you are using the Level 3 license for LeonardoSpectrum, you can display an 
RTL Schematic for your design by clicking the  button. You can move around 
the schematic using the scroll bars and the diagram can be enlarged inside the 
browser by choosing Zoom In from the Zoom cascade of the Schematic Viewer 
pulldown menu.

You can cross-probe from the schematic to the corresponding object in an HDS 
source diagram. This is achieved by selecting an instance on the schematic and 
clicking the right mouse button. To view the HDS source diagram choose Trace 
to HDL Designer from the popup menu. The relevant HDS design unit view is 
displayed.

i
The Schematic Viewer is not available with a LeonardoSpectrum level 2 
license. However, a license can be added if you obtain an additional 
license feature for LeonardoInsight.
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FPGA Advantage Tutorial Further Information
Close the text editor windows and do the following:

Close the LeonardoSpectrum window by choosing Exit from the 
LeonardoSpectrum File menu, choosing No from the confirmation dialog box.

Close HDS by choosing Exit from the File menu in the Design Manager window 
and choosing Yes from the confirmation dialog box.

Further Information
You have now completed the FPGA Advantage with LeonardoSpectrum Tutorial 
and seen the complete design flow from importing HDL into HDS, through 
verification using the ModelSim simulator and used LeonardoSpectrum to 
synthesize a gate level netlist.

Each of these tools support a large range of features which cannot be illustrated in 
this simple tutorial. For more information, see the documentation which is 
available from the Help menu in each tool.

You can also access documentation from the FPGA Advantage 6.1 > Bookcase 
which can be opened on Windows platforms from the Programs cascade of the 
Start menu. 

You can access this document on UNIX by opening the PDF document named 
DocIndex.pdf which can be found in the FPGA Advantage installation at: 
<install_dir>/Doc/DocIndex.pdf.

The FPGA Advantage Bookcase can also be accessed from the Help pulldown 
menu in the Design Manager on both Windows and UNIX by selecting Help > 
FPGA Advantage Bookcase.
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a license to the Beta Code, which Mentor Graphics may choose not to release commercially in any form. If 
Mentor Graphics authorizes you to use the Beta Code, you agree to evaluate and test the Beta Code under normal 
conditions as directed by Mentor Graphics. You will contact Mentor Graphics periodically during your use of the 
Beta Code to discuss any malfunctions or suggested improvements. Upon completion of your evaluation and 
testing, you will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths, 
weaknesses and recommended improvements. You agree that any written evaluations and all inventions, product 
improvements, modifications or developments that Mentor Graphics conceives or made during or subsequent to 
this Agreement, including those based partly or wholly on your feedback, will be the exclusive property of 

This license is a legal “Agreement” concerning the use of Software between you, the end user, either 
individually or as an authorized representative of the company acquiring the license, and Mentor 
Graphics Corporation and Mentor Graphics (Ireland) Limited, acting directly or through their 
subsidiaries or authorized distributors (collectively “Mentor Graphics”). USE OF SOFTWARE 
INDICATES YOUR COMPLETE AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND 
CONDITIONS SET FORTH IN THIS AGREEMENT. If you do not agree to these terms and conditions, 
promptly return, or, if received electronically, certify destruction of, Software and all accompanying items 
within five days after receipt of Software and receive a full refund of any license fee paid. 



Mentor Graphics. Mentor Graphics will have exclusive rights, title and interest in all such property. The 
provisions of this subsection shall survive termination or expiration of this Agreement.

4. RESTRICTIONS ON USE. You may copy Software only as reasonably necessary to support the authorized 
use. Each copy must include all notices and legends embedded in Software and affixed to its medium and 
container as received from Mentor Graphics. All copies shall remain the property of Mentor Graphics or its 
licensors. You shall maintain a record of the number and primary location of all copies of Software, including 
copies merged with other software, and shall make those records available to Mentor Graphics upon request. 
You shall not make Software available in any form to any person other than employees and contractors, 
excluding Mentor Graphics' competitors, whose job performance requires access. You shall take appropriate 
action to protect the confidentiality of Software and ensure that any person permitted access to Software does not 
disclose it or use it except as permitted by this Agreement. Except as otherwise permitted for purposes of 
interoperability as specified by applicable and mandatory local law, you shall not reverse-assemble, reverse-
compile, reverse-engineer or in any way derive from Software any source code. You may not sublicense, assign 
or otherwise transfer Software, this Agreement or the rights under it, whether by operation of law or otherwise 
(“attempted transfer”) without Mentor Graphics' prior written consent and payment of Mentor Graphics then-
current applicable transfer charges. Any attempted transfer without Mentor Graphics’ prior written consent shall 
be a material breach of this Agreement and may. at Mentor graphics’ option, result in the immediate termination 
of the Agreement and licenses granted under this Agreement. The provisions of this section 4 shall survive the 
termination or expiration of this Agreement.

5. LIMITED WARRANTY.

5.1. Mentor Graphics warrants that during the warranty period, Software, when properly installed, will 
substantially conform to the functional specifications set forth in the applicable user manual. Mentor 
Graphics does not warrant that Software will meet your requirements or that operation of Software will be 
uninterrupted or error free. The warranty period is 90 days starting on the 15th day after delivery or upon 
installation, whichever first occurs. You must notify Mentor Graphics in writing of any nonconformity 
within the warranty period. This warranty shall not be valid if Software has been subject to misuse, 
unauthorized modification or installation. MENTOR GRAPHICS' ENTIRE LIABILITY AND YOUR 
EXCLUSIVE REMEDY SHALL BE, AT MENTOR GRAPHICS' OPTION, EITHER (A) REFUND OF 
TH E P RICE P AID  U PO N RETU RN OF S OFTW ARE TO  M EN TOR GRAP HICS  OR (B)  
MODIFICATION OR REPLACEMENT OF SOFTWARE THAT DOES NOT MEET THIS LIMITED 
WARRANTY, PROVIDED YOU HAVE OTHERWISE COMPLIED WITH THIS AGREEMENT. 
MENTOR GRAPHICS MAKES NO WARRANTIES WITH RESPECT TO: (A) SERVICES; (B) 
SOFTWARE WHICH IS LICENSED TO YOU FOR A LIMITED TERM OR LICENSED AT NO COST; 
OR (C) EXPERIMENTAL BETA CODE; ALL OF WHICH ARE PROVIDED “AS IS.” 

5.2. THE WARRANTIES SET FORTH IN THIS SECTION 5 ARE EXCLUSIVE. NEITHER MENTOR 
GRAPHICS NOR ITS LICENSORS MAKE ANY OTHER WARRANTIES, EXPRESS, IMPLIED, OR 
STATUTORY, WITH RESPECT TO SOFTWARE OR OTHER MATERIAL PROVIDED UNDER THIS 
AGREEMENT. MENTOR GRAPHICS AND ITS LICENSORS SPECIFICALLY DISCLAIM ALL 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
AND NON-INFRINGEMENT OF INTELLECTUAL PROPERTY.

6. LIMITATION OF LIABILITY. EXCEPT WHERE THIS EXCLUSION OR RESTRICTION OF LIABILITY 
WOULD BE VOID OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL MENTOR 
GRAPHICS OR ITS LICENSORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR SAVINGS) WHETHER BASED ON 
CONTRACT, TORT OR ANY OTHER LEGAL THEORY, EVEN IF MENTOR GRAPHICS OR ITS 
LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT 
SHALL MENTOR GRAPHICS' OR ITS LICENSORS' LIABILITY UNDER THIS AGREEMENT EXCEED 
THE AMOUNT PAID BY YOU FOR THE SOFTWARE OR SERVICE GIVING RISE TO THE CLAIM. IN 
THE CASE WHERE NO AMOUNT WAS PAID, MENTOR GRAPHICS AND ITS LICENSORS SHALL 
HAVE NO LIABILITY FOR ANY DAMAGES WHATSOEVER.



7. LIFE ENDANGERING ACTIVITIES. NEITHER MENTOR GRAPHICS NOR ITS LICENSORS SHALL 
BE LIABLE FOR ANY DAMAGES RESULTING FROM OR IN CONNECTION WITH THE USE OF 
SOFTWARE IN ANY APPLICATION WHERE THE FAILURE OR INACCURACY OF THE SOFTWARE 
MIGHT RESULT IN DEATH OR PERSONAL INJURY.

8. INDEMNIFICATION. YOU AGREE TO INDEMNIFY AND HOLD HARMLESS MENTOR GRAPHICS 
AND ITS LICENSORS FROM ANY CLAIMS, LOSS, COST, DAMAGE, EXPENSE, OR LIABILITY, 
INCLUDING ATTORNEYS' FEES, ARISING OUT OF OR IN CONNECTION WITH YOUR USEOF 
SOFTWARE AS DESCRIBED IN SECTION 7.

9. INFRINGEMENT.

9.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against you alleging that 
Software infringes a patent or copyright or misappropriates a trade secret in the United States, Canada, 
Japan, or member state of the European Patent Office. Mentor Graphics will pay any costs and damages 
finally awarded against you that are attributable to the infringement action. You understand and agree that as 
conditions to Mentor Graphics’ obligations under this section you must: (a) notify Mentor Graphics 
promptly in writing of the action; (b) provide Mentor Graphics all reasonable information and assistance to 
defend or settle the action; and (c) grant Mentor Graphics sole authority and control of the defense or 
settlement of the action.

9.2. If an infringement claim is made, Mentor Graphics may, at its option and expense: (a) replace or modify 
Software so that it becomes noninfringing; (b) procure for you the right to continue using Software; or (c) 
require the return of Software and refund to you any license fee paid, less a reasonable allowance for use.

9.3. Mentor Graphics has no liability to you if infringement is based upon: (a) the combination of Software with 
any product not furnished by Mentor Graphics; (b) the modification of Software other than by Mentor 
Graphics; (c) the use of other than a current unaltered release of Software; (d) the use of Software as part of 
an infringing process; (e) a product that you make, use or sell; (f) any Beta Code contained in Software; (g) 
any Software provided by Mentor Graphics' licensors who do not provide such indemnification to Mentor 
Graphics' customers; or (h) infringement by you that is deemed willful. In the case of (h) you shall reimburse 
Mentor Graphics for its attorney fees and other costs related to the action upon a final judgment. 

9.4. THIS SECTION 9 STATES THE ENTIRE LIABILITY OF MENTOR GRAPHICS AND ITS 
LICENSORS AND YOUR SOLE AND EXCLUSIVE REMEDY WITH RESPECT TO ANY ALLEGED 
PATENT OR COPYRIGHT INFRINGEMENT OR TRADE SECRET MISAPPROPRIATION BY ANY 
SOFTWARE LICENSED UNDER THIS AGREEMENT.

10. TERM. This Agreement remains effective until expiration or termination. This Agreement will automatically 
terminate if you fail to comply with any term or condition of this Agreement or if you fail to pay for the license 
when due and such failure to pay continues for a period of 30 days after written notice from Mentor Graphics. If 
Software was provided for limited term use, this Agreement will automatically expire at the end of the 
authorized term. Upon any termination or expiration, you agree to cease all use of Software and return it to 
Mentor Graphics or certify deletion and destruction of Software, including all copies, to Mentor Graphics' 
reasonable satisfaction.

11. EXPORT. Software is subject to regulation by local laws and United States government agencies, which 
prohibit export or diversion of certain products, information about the products, and direct products of the 
products to certain countries and certain persons. You agree that you will not export any Software or direct 
product of Software in any manner without first obtaining all necessary approval from appropriate local and 
United States government agencies.

12. RESTRICTED RIGHTS NOTICE. Software was developed entirely at private expense and is commercial 
computer software provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S. 
Government or a U.S. Government subcontractor is subject to the restrictions set forth in the license agreement 
under which Software was obtained pursuant to DFARS 227.7202-3(a) or as set forth in subparagraphs (c)(1) 



and (2) of the Commercial Computer Software - Restricted Rights clause at FAR 52.227-19, as applicable. 
Contractor/manufacturer is Mentor Graphics Corporation, 8005 SW Boeckman Road, Wilsonville, Oregon 
97070-7777 USA. 

13. THIRD PARTY BENEFICIARY. For any Software under this Agreement licensed by Mentor Graphics from 
Microsoft or other licensors, Microsoft or the applicable licensor is a third party beneficiary of this Agreement 
with the right to enforce the obligations set forth in this Agreement.

14. AUDIT RIGHTS. With reasonable prior notice, Mentor Graphics shall have the right to audit during your 
normal business hours all records and accounts as may contain information regarding your compliance with the 
terms of this Agreement. Mentor Graphics shall keep in confidence all information gained as a result of any 
audit. Mentor Graphics shall only use or disclose such information as necessary to enforce its rights under this 
Agreement.

15. CONTROLLING LAW AND JURISDICTION. THIS AGREEMENT SHALL BE GOVERNED BY AND 
CONSTRUED UNDER THE LAWS OF OREGON, USA, IF YOU ARE LOCATED IN NORTH OR SOUTH 
AMERICA, AND THE LAWS OF IRELAND IF YOU ARE LOCATED OUTSIDE OF NORTH AND SOUTH 
AMERICA. All disputes arising out of or in relation to this Agreement shall be submitted to the exclusive 
jurisdiction of Dublin, Ireland when the laws of Ireland apply, or Wilsonville, Oregon when the laws of Oregon 
apply. This section shall not restrict Mentor Graphics’ right to bring an action against you in the jurisdiction 
where your place of business is located.

16. SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void, 
invalid, unenforceable or illegal, such provision shall be severed from this Agreement and the remaining 
provisions will remain in full force and effect.

17. MISCELLANEOUS. This Agreement contains the parties’ entire understanding relating to its subject matter 
and supersedes all prior or contemporaneous agreements, including but not limited to any purchase order terms 
and conditions, except valid license agreements related to the subject matter of this Agreement (which are 
physically signed by you and an authorized agent of Mentor Graphics) either referenced in the purchase order or 
otherwise governing this subject matter. This Agreement may only be modified in writing by authorized 
representatives of the parties. Waiver of terms or excuse of breach must be in writing and shall not constitute 
subsequent consent, waiver or excuse. The prevailing party in any legal action regarding the subject matter of 
this Agreement shall be entitled to recover, in addition to other relief, reasonable attorneys' fees and expenses.
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